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Symbols The following symbols are used in this manual to highlight special 
information:

NOTE: Indicates a special note.

TIP: Indicates a tip.

CAUTION: Alerts you to give this special caution.

Tells where to find more details about a particular subject.

💬💬

💡💡

⚠

👍👍❤ !

❗ 👌👌!

🎖🎖 🕺🕺 🚫🚫

🔔🔔 😀😀 🙂🙂

And in this wonderful new world of social media, we’ve included a few 
things to alert you to user favorites, much loved features and other emotional 
reactions.

Anything in red is probably obsolete and needs checking.

Anything in green needs a hyperlink on the page.

How to Read This Document
This manual is an interactive PDF that acts in some ways like a book and also like a program, with links that 
will take you from one page to another.  

To operate properly within PowerCADD, the document name must be:

PowerCADD™ Tutorial.pdf

And it must be installed in the PowerCADD Documentation directory, specifically:

Applications/PowerCADD 9/Documentation/PowerCADD™ Tutorial.pdf

Please feel free to download and install this manual on an iPad where it will be an excellent reference easily 
viewed and navigated in iBooks, Adobe Acrobat or any other PDF viewer app, however some features of the 
interactive PDF will not work on an iOS device such as the Previous and Next page buttons, and any links to 
another PDF such as to the PowerCADD Documentation or Tutorial.  

This manual can be downloaded to your iPad from

http://www.seqair.com/WildTools/Documentation/Docs.html

!

http://www.seqair.com/WildTools/Documentation/Docs.html
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This tutorial is for the experienced Macintosh user who wants to get up on 
the learning curve of PowerCADD quickly.

This chapter is organized around nine major headings:

 Document Window 
 Floating Windows
 PowerCADD Preferences 
 Drawing Setup Settings 
 How to Get Started
 Dynamic Snapping
 Edit Window
 Math in Dialog Boxes
 Putting It All Together

In Document Window, you will become familiar with the various parts of 
PowerCADD’s face, and how to use the scroll bar, guides, and layer buttons.

Floating Window will introduce you to the fundamentals of how to 
customize your workspace by adjusting the settings for floating windows.

PowerCADD Preferences will introduce you to the fundamentals of 
working with PowerCADD Preferences to customize your workspace.

Drawing Setup will introduce you to the fundamentals of working with 
PowerCADD Drawing Setup settings to customize your workspace.

How to Get Started will step you through setting up PowerCADD to get 
started. It is not intended to replace the balance of the manual, but to help 
you quickly get ready to design.

Dynamic Snapping and Edit Window will introduce two important features 
of PowerCADD, Dynamic Snapping and the Edit Window. 

Dynamic Snapping is always working invisibly and intelligently while you 
are drawing.  The Edit Window provides interactive object information, as 
well as a method to parametrically enter an object’s dimensions.  These two 
features will significantly enhance both your speed and accuracy.

At the end of the Dynamic Snapping and the Edit Window sections there are 
tutorial exercises to reinforce your understanding of these two important 
features of PowerCADD.

Math in Dialog Boxes will introduce you to how you can enter Imperial and 
Metric dimensions as well as some basic math capabilities.

About This Tutorial

Anchor
[AboutTutorial]
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Putting It All Together will step you through using the Edit Window and 
snapping in conjunction with some tools and menu commands to show 
you how to construct a bearing, the easy way.  The method used could 
just as easily be used to draw a bush or make a clock.  As you can see, 
PowerCADD can put your ideas to work for you.  

You can draw anything with PowerCADD.  

And just in case you might feel a little apprehensive, we’re going to show 
you a few samples of what some of our users have done.  See below and on 
the subsequent pages.
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When you open a new or existing PowerCADD file, you will see the  on 
your Macintosh screen.  Opening a new drawing will produce an empty 
Untitled document.

Take a moment to study the PowerCADD document window pictured 
below.

Document Window

Typical of most Macintosh programs, the Menu bar, located at the top of 
the screen, contains various pull-down menus of PowerCADD options and 
commands which you can choose with your mouse.

The Dynamic Ruler Guides display within the horizontal and vertical rulers 
to help you track your cursor movements. 

The Tool palette to the left of the window consists of drawing tools you can 
use to construct lines, circles, arcs, polygons, and other geometric designs. 
The Tool palette, and any floating window, may be positioned anywhere 
you like on screen.  If your computer has multiple monitors you may move 
a Tool palette or floating window or the document window onto the second 
monitor.

Anchor
[DocumentWindow]



Tutorial6

The largest and most frequently used area within the PowerCADD document 
window is the drawing area that usually consists of gray horizontal and 
vertical gridlines.  These gridlines are visual references to aid you in drawing 
and do not appear in printed documents.  Gridlines may be turned On or 
Off in the Drawing Setup dialog. 

For more information on working with Gridlines and other drawing window 
features, review the Drawing Setup and Preferences features discussed in the 
Menu chapter.

The drawing area is the Macintosh screen representation of a sheet of 
drawing paper.  How much of the drawing area you see will vary based on 
the size and resolution of your computer monitor, the drawing sheet size, 
drawing zoom level, and how large or small the drawing window size has 
been set.  By using the vertical and horizontal scroll bars, it is possible for 
you to view the total drawing area.  Later, you will learn how to choose a 
command called Reduce To Fit from the Menu bar that displays the entire 
drawing area on the computer screen.  Other tools and menu commands 
also exist which allow you to quickly and easily navigate within the drawing 
area.

PowerCADD supports large screen displays and multiple monitors.  This 
allows you to see more of the drawing area, view multiple drawings at once, 
or organize your drawing window on one screen and floating windows on 
another.  To resize a drawing window to fit your entire screen simply click 
the maximize window button in the top left corner of the drawing window. 
The drawing window will automatically reduce in size to its previously 
dragged dimension, or expand to fill your screen.

PowerCADD will routinely open a new drawing window with approximately 
an 8” x 10” drawing area, however you have complete control over the sheet 
size up to a maximum of 200” x 200”.  Changing the sheet size is quick and 
easy and will be covered later in this chapter.

!
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The PowerCADD Toolbar runs across the top of all open drawings providing 
you one-click access to many commonly used actions.  To apply an action 
from the Toolbar, simply click the icon.  If an icon is dimmed (unavailable) 
select an object (or multiple objects) first, then click on the icon to apply 
the action.  If you prefer to work with the toolbar hidden simply click the 
Hide Toolbar button in the top right corner of the drawing window.  If you 
change your mind simply click the button again to see the toolbar.  Each 
drawing window can show or hide the toolbar independently.

To see a description of what a button does hold the cursor over the button 
and a brief description will appear.  Press the Command key when the brief 
description is displayed to see additional information about a button.

As you become more familiar with PowerCADD and begin to learn which 
actions you perform most often, you can add, remove, and rearrange toolbar 
items to suit your workflow. 

To customize the Toolbar:
 Click the Customize icon in the toolbar (top right) or Control- or right-click 

on the Toolbar to choose Customize Toolbar from the contextual menu. 
 The Customize Toolbar sheet will appear (pictured below).
 To rearrange an item in the toolbar, drag its icon to the new location.
 To add an item in the toolbar, drag its icon from the sheet into the 

toolbar at the top of the screen.
 To restore the default set of toolbar items, drag the default set to the 

toolbar.
 To change how items are displayed choose the desired option from the Show 

popup menu.  For example, you may choose Text and Icons or Text Only.
 Click Done when you’ve made the desired changes and have the items 

displayed in all open drawings.

You can also perform some toolbar customization without using the 
Customize Toolbar sheet.  To remove an item press the Command key while 
dragging the item out of the toolbar.  To move an item press the Command  
key while dragging the item in the toolbar.  You can also Control- or right-
click on a toolbar item to see additional choices from the contextual menu.

Toolbar

Customizing the Toolbar

Does Customize icon 
still exits?
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Each button corresponds to a particular PowerCADD menu item action or 
special feature.  We’ll cover the special features here but to learn more about 
the other items please reference the index to locate additional information 
on specific features.  For example, to learn more about Hide Hatches please  
look in the Menu Chapter.

Clicking Redraw, or pressing the zero (0) key, will force the drawing 
window to refresh.  This can be helpful to refresh your screen if things don’t 
seem to look correct after performing a particular action.  Clicking Kill 
Redraw, or pressing Command-Period, will stop a redraw operation.  For 
example if you have a large or complex drawing with lots of shadows, you 
may want to stop the redraw to save time.

The Selected status field displays the current number of selected objects 
in the drawing.  In previous versions of PowerCADD this information 
appeared in the Status Window.

The Nudge amount field allows you specify the distance that selected objects 
will be moved up, down, left, or right when the corresponding arrow key 
is pressed.  To enter a nudge value, click in the Nudge field and type a 
number.  To select a nudge value, click on the pop-up arrow and select it 
from the list.  To learn more about working with Nudge, please see Nudge 
Preferences in the Menu Chapter.

Sometimes a drawing window might be too small to display all the items in 
the Toolbar.  When that happens a special reveal icon appears on the right 
side, below the Show/Hide Toolbar button.  Click on the reveal icon to see 
a contextual menu of any hidden toolbar items.  Choosing an item from the 
menu is the same as clicking on the item in the toolbar.

Both seem obsolete.

Doesn’t show the number here.

👍👍❤ !👌👌
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The File Path Navigator allows you to quickly find the path of a saved 
drawing or a Symbol Library and to go to any folder or volume in that path.

To see the path of the current drawing or Symbol Library:
	 Press the Command key and click on the document’s name in the 

document title bar.
	 The file pathname is displayed in the list.  Choose a folder or volume 

in the list to open the item in the Finder.

The scroll bars are used to view different parts of a PowerCADD document.

To use the scroll bars:
	 Click on the scroll arrow indicating the direction in which you wish 

to move.  Repeat this process until you see the desired area of the 
PowerCADD document.

To scroll more quickly:
	 Click on the gray area of the appropriate scroll bar.  The PowerCADD 

document will shift horizontally or vertically the distance of the current 
window.

For more information on the various methods of scrolling, panning, 
zooming, and other methods of drawing navigation, see Other Tips in Tips, 
Hints & Shortcuts chapter. 

The snap indicator will assist you when you are snapping one object to 
another. The individual letters represent different snap options.  When a 
dynamic snap point has been located, the box corresponding to the snap 
will highlight and the snap locator will be visible.  The dynamic snap 
options will be explained later in this chapter. 

For more information concerning Dynamic Snap, see Dynamic Snapping. 
Also see Dynamic Snap Indicator in the Menu chapter.

Guides are construction lines that aid in drawing and placing objects. 
Guides can be displayed on top or behind of all other objects.  Colors can 
also be assigned to them. 

Dynamic Snap Indicator

Guides

Guides are created by dragging them from the rulers.  The cursor changes 
when the mouse nears the rulers, indicating a different action is about to 
take place.  They can be placed anywhere in a drawing.  Normally guides are 
parallel to the rulers, however, they can be snapped parallel to any object. 
When placing Guides, they can also be snapped to a vertex, an endpoint 
or perpendicular to a surface.  Guides do not print.  They are used solely 

File Path Navigator

Scroll Bars

!

!
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as references to help you accurately position objects.  The ruler indicators, 
located at the top left corner of the document window make ruler guide 
selection obvious. 

For more information on working with Guides, see Guidelines discussed in 
the Menu chapter.
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Drawing Origin The Drawing Origin, or 0,0 location, can be moved or changed when 
necessary.  A Zero marker (+) indicates the 0,0 location is at the upper left-
hand corner of the drawing page.  When the cursor is moved to the upper 
left corner to reestablish the drawing origin, the cursor will change into an 
intersecting double arrow line cursor, confirming the 0,0 location can be 
changed.  These two intersecting lines will disappear when the 0,0 location 
has been moved.

To change the Drawing Origin:
 Choose Drawing Setup from the Layout menu and select the Show 

tab. Make sure the Rulers box is checked. Alternatively, Control- or 
right-click in a blank area of the drawing window, and choose Show 
Rulers from the contextual menu. 

 Place the cursor on the shaded box in the upper left corner of the 
drawing area. As you approach the rulers, the cursor will change 
indicating an action is about to take place. This box will not appear 
unless the rulers are showing.

 Drag the cursor into the drawing area. A crosshair will appear to aid 
you in setting the Drawing Origin.

 Release the mouse button at the point on the grid corresponding to 
the new Drawing Origin. Notice the ruler settings have now been 
changed.
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To change the Drawing Origin of a single ruler:
 Make sure Show Rulers is selected in Drawing Setup under the Layout 

menu as described earlier. 
 Press in the shaded box in the upper left corner of the drawing area.
 Drag the cursor to the point on the ruler (either horizontal or vertical) 

where you wish to place the Drawing Origin.
 Release at the point on the ruler corresponding to the new Drawing 

Origin.  Notice the ruler settings for one ruler has been changed.

To reset the Drawing Origin to the upper left corner of the drawing:
 Make sure you have selected Show Rulers in Drawing Setup under the 

Layout menu as described earlier.
 Click in the box in the upper left corner of the drawing area. Notice the 

Drawing Origin has now returned to the default position.

The Drawing Origin may be snapped to objects or to the grid.  Press the 
letter corresponding to the type of dynamic snap desired while dragging the 
Drawing Origin into place.  The Drawing Origin will snap to the location 
just as objects do.
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Floating Windows

Close Button
Click this to close 
any floating 
window.

Edit Window Display.
Click to toggle the number

of fields displayed in the
Edit Window.

Resize box.
Some floating windows

have a resize box.  Click
and drag here to reshape

or resize the window.
Window Settings.

Press the Control key
and click in the body

of a floating window to
customize its settings.

Floating Windows provide direct access to various features and are managed 
from either the Anchor Window or choosing an item from the Window 
menu. 

When you activate a floating window, either by clicking on a window 
name in the Anchor Window or choosing it from the Window menu, it 
is opened in the last saved position.  When a floating window is closed its 
name appears in the Anchor Window.  When open, floating windows are 
not listed in the Anchor Window. 

Anchor
[FloatingWindow]
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To customize the settings of a floating window:
 Control- or right-click anywhere in a blank area of a floating window. 

The following dialog will appear:

Check this box if you want the edges of�
this floating window to interact with�

other floating windows or the screen edges.
Check this box if you want the window to�
automatically snap to the edges of the�
screen. Dragging the window close to a�
screen edge will snap it in place.

Check this box if you want this floating�
window  to stick to other floating windows.

Check this box if you want this window to�
move with other windows it is stuck to.�
Moving one floating window moves all�
windows that are stuck together.

Drag this slider to adjust how�
transparent this floating window�
should be in it's normal state. A�
value of 100% is solid and you�

cannot see through it.
Check this box if you want this floating�
window to automatically fade (become see�
through) when it is idle. When the window is�
active it returns to it's normal state (see�
Window Opacity setting).

Enter a number here to specify how many�
seconds this floating window should be idle�
before it automatically fades.

Check this box if you want the window to�
fade when it's over a drawing window.

Click the mouse here when you are�
finished adjusting the settings for�

this floating window.

Drag this slider to adjust now�
transparent the window should�

become when it automatically fades.�
A value of 10% will be very transparent,�

a value of 100% will be solid.

Check this box if you want the window�
to fade when it is over your Desktop.

	 Make the desired setting changes and click Done.
Being able to independently adjust the settings for each floating window 
provides you a great deal of flexibility in customizing your workspace.

NOTE: The normal state for a floating window is determined by the 
Window Opacity setting.  A floating window that has faded on screen will 
automatically return to its normal state when you move the cursor over it

The ability to turn floating window Auto-Fade On or Off is controlled 
by the Window Fading Preference settings.  If the Auto-Fade settings are 
dimmed as shown on the left: 
 Choose Preferences from the PowerCADD menu.
 Select the General tab.
 Check the Window Fading box to turn it on.
 Click OK.
 Try to set the Auto-Fade settings for the floating window again as 

described earlier.

For more information on working with Floating Windows, see Anchor 
Window discussed in the Menu chapter.

💬💬
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Layer Navigation Arrows are located in the lower left corner of the 
document window. By clicking on these buttons, you can quickly move up 
and down various layers in a PowerCADD drawing. See Layers under the 
Layout menu for more information concerning the use of drawing layers. 

Layer Navigation Arrows

The Edit Window allows you to move, rotate or resize objects by keyboard 
entry.  The Edit Window accurately places objects in a drawing according to 
X,Y coordinates rather than snapping or visually lining up with rulers.  You may 
also accurately specify the size of an object by entering its parameters.  The Edit 
Window is a valuable tool when you need to do precision drawings.

Exercises using the Edit Window are included later in this chapter so you 
can quickly see the speed and precision advantages of the keyboard for some 
of your entries.

The PowerCADD Preferences dialog contains various settings for 
customizing your workspace and the overall behavior of PowerCADD. 
Changes made to PowerCADD Preferences are applied globally and affect 
all PowerCADD drawings. 

To change PowerCADD Preferences:
	 Choose Preferences from the PowerCADD menu and the Preferences 

dialog will open.

Edit Window

PowerCADD Preferences

	 Preference settings are grouped into logical collections of related items. 
To access a particular collection of Preference settings select a tab 
from the top of the dialog. In the example shown above, selecting the 
General tab displays the related preferences.

	 To make a change simply select the desired preference settings from the 
displayed options and click OK.

	 PowerCADD remembers your custom settings. The settings remain in 
effect until you return to the Preferences dialog and revise them.

For more information on working with PowerCADD Preferences and a 
complete description of all the Preference settings, see Preferences discussed 
in the Menu chapter.

Anchor
[PowerCADDPreferences]
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The PowerCADD Drawing Setup dialog contains various settings 
for customizing specific drawing parameters, allowing you to tailor 
PowerCADD to your unique drawing requirements and style. Drawing 
Setup changes are saved with the drawing, they do not affect other drawings 
or overall application behavior (see PowerCADD Preferences above). 

To change Drawing Setup settings:
	 Choose Drawing Setup from the Layout menu and the Drawing Setup 

dialog will open.

Drawing Setup Settings

 Drawing Setup settings are grouped into logical collections of related items. 
To access a particular collection of Drawing Setup settings select a tab from 
the top of the dialog box. In the example shown above, selecting the Units 
tab displays settings related to drawing scale, angle and area units.

	 To make a change simply select the desired settings from the displayed 
options and click OK.

The changes take effect immediately after the Drawing Setup dialog box 
closes.

Drawing Setup settings are saved with the drawing.  The settings remain in 
effect until you return to the Drawing Setup dialog and revise them.

For more information on working with Drawing Setup settings and a 
complete description of all the settings, see Drawing Setup discussed in the 
Menu chapter.

NOTE: To help you save time, after you have customized your Drawing 
Setup you should also consider adding other standard items to the drawing 
such as a title block or create a set of standard drawing layers.  All of these 
changes may be saved as a PowerCADD Stationery Pad.  Every time you 
open a customized Stationery Pad drawing you are immediately presented 
with your customized settings.  There is no limit to the number of Stationery 
Pad drawings you can have or the type of content they contain.  You can 
even customize the type of drawing PowerCADD opens up by default when 
you choose New from the File menu.

💬💬

Anchor
[PCDrawingSetup]
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In traditional manual drafting and design, you make some fundamental 
decisions before you start a drawing which include:
	 Drawing method
	 Drawing scale
	 Scale increments
	 Units of measure
	 Size of paper
	 Number of acetate overlays to be used
	 Setting the drafting machine angles

PowerCADD provides a simple manner of making these same decisions, 
and provides the equivalents to the full manual drafting board environment, 
allowing you to use the drawing set-up process you already know. The 
following provides a brief overview of how to get started with PowerCADD 
quickly and efficiently.

After you’ve launched PowerCADD by double-clicking the application 
icon, you’re automatically presented with a new, empty sheet of drawing 
paper. 

Let’s start the decision-making process just like we did in manual drafting. 

How to Get Started

Ph
il 

Lo
he

ed

Anchor
[HowToGetStarted]
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What size of paper do you want to draw on?
Choose Page Setup from the File menu and the following dialog will appear. 

This is where you choose the printed page size and orientation of your 
drawing.  The list of drawing sheet sizes to choose from will be different 
depending on the type of printer you have selected.

In this example you’ll make the following choices because to draw on an 
11x17 inch sheet of paper:

	 Choose Any Printer from the Format for pop-up menu.
	 Choose Tabloid from the Paper Size pop-up menu.
	 Select the Landscape (horizontal) Orientation icon and click OK.

When you click OK, PowerCADD’s Drawing Setup dialog automatically 
opens as shown here.  A preview of the drawing page and any content is 
shown in the left hand area of the dialog.  Since you haven’t drawn anything 
yet this area is empty.  This is where you continue the page setup process 
and make additional drawing setup decisions.

	 The vertical slider on the left of the dialog lets you zoom out to see 
additional sheets of paper.  Drag the slider bar down slightly, as shown 
above, to see more of the white sheet of paper

	 For Page Mode Settings, select the Tiled Printable Areas radio button and 
double-click on the top left most white tile in the drawing page preview area.

Notice when you double-click on one tile the values in the Printer Settings 
and Work Area fields are updated automatically.
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In the Printer Settings fields notice the values for Paper Size are different 
than Printable Area. 

Notice the values for Work Area are the same as Printable Area.  The 11x17 
inch tabloid sheet of paper has a Printable Area and Work Area of 16.5 
x 10.5 inches.  PowerCADD automatically used the hard clipping limits 
(margins) required for the chosen printer.  The smaller dimension represents 
the actual printable area for the 11x17 sheet of paper based on the chosen 
printer. 

In this case, the Printer Settings fields indicate the margins are 0.25” on all 
sides.  This ensures the white drawing area you see on screen is the actual 
printable area for the chosen printer and page size.  Just like the manual 
drafting world, objects drawn on the white sheet of paper will print.  If you 
draw in the grey area (off the paper) the objects will not print.

	 Click OK and the drawing window now shows you a white drawing 
area which is 16.5” x 10.5”. If your monitor is smaller than 11x17”, 
choose Reduce to Fit from the View menu to see the entire sheet of 
drawing paper.

Page Mode options in the Drawing Setup, Size dialog, allow you to draw 
on Tiled Printable Areas of multiple sheets of paper, or on a single sheet of 
paper displayed as a Full Page with Margins.

In the previous example, the Page Mode settings were set to Tiled Printable 
Areas.  You selected a single 11x17 tile by double-clicking on the top left 
most tile in the Drawing Setup, Size, dialog box.  If you wanted to draw on 
multiple sheets of 11x17 paper you could have simply clicked and dragged 
across a range of tiles.  

The margins for those pages are not shown in the drawing window.  Rather, 
the white area you saw on screen is only the printable area for the chosen 
printer and page size.

💬💬



Tutorial20

If you want to draw on a single sheet of paper and see the margins on screen 
in the drawing window then you need to choose Full Page w/Margins from 
the Page Mode setting options.

	 Choose New from the File menu to open a new, untitled, PowerCADD 
drawing.

	 Choose Any Printer from the Format for pop-up menu.
	 Choose Tabloid from the Paper Size pop-up menu.
	 Select the Landscape (horizontal) Orientation icon and click OK.

When you click OK, PowerCADD’s Drawing Setup dialog automatically 
opens as shown here.  This is where you’ll continue the drawing setup 
process as before, only this time you’ll be choosing to draw on a single sheet 
of paper with margins.

	 For Page Mode Settings, select the Full Page w/Margins radio button 
and double-click on the top left most white tile in the drawing page 
preview area.

Notice when you double-click on the tile the values in the Printer Settings 
and Work Area fields are updated automatically.

In the Printer Settings fields notice the values for Paper Size are different 
than Printable Area.  Notice the values for Work Area are the same as Paper 
Size.  Although the 11x17 sheet of paper only has a printable area of 16.5 x 
10.5 inches, PowerCADD is going to show you a total Work Area of 11x17 
and display the margins on screen.  In this case, the Printer Setting fields 
indicate the margins are 0.25” on all sides.  The area inside those margins is 
the actual printable area and PowerCADD will show you both those areas 
on screen.  If you draw in the grey area (off the paper) or in the margins the 
objects will not print.

	 Click OK and the drawing window now shows you a white drawing 
area (the Printable Area) which is 16.5” x 10.5” and a total Work Area 
of 11”x17”.  If your monitor is smaller than 11x17”, choose Reduce to 
Fit from the View menu to see the entire sheet of drawing paper.
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By default, the drawing origin (zero, zero) is in the top left corner of the 
Printable Area.  Remember, your Work Area is 11x17 inches but the printer 
in our example has margins of 0.25 inches top, right, bottom and left.  

This means the drawing origin has moved down 0.25 inches and left 0.25 
inches.  Therefore the rulers for your 11x17 sheet of paper reflect a total 
horizontal distance of 16.75 inches and a total vertical distance of 10.75 
inches. 

To reset the drawing origin to the top left corner of the Work Area
	 Place the cursor in the top left corner between the drawing rulers and 

click the mouse. 

The rulers will update to reflect values of 11x17 inches but the margins and 
total printable area are not affected.
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What scale do you want to draw at?
In manual drafting, geometry is drawn to a scale and the same holds true 
in PowerCADD.  To set your drawing scale, choose Drawing Setup from 
the Layout menu and select the Units Tab, the following dialog will appear:

Each section of the dialog contains pop-down menus or fields allowing you 
to specify drawing scale, accuracy, drawing angles and other parameters.  In 
our example we chose to draw in Feet & Inches at a scale of 1/4”=1’-0” with 
an accuracy of 1/16”.  Simply choose a setting from any pop-down menu 
or type a value in a field.

The settings in the dialog box set the parameters for the specific drawing 
and stay in effect until you change them.  You can change these settings 
any time you wish to draw at a different scale within the same drawing.  
When you change the scale after the initial setting, the change has the same 
effect as flipping your scale ruler when drawing details.  Objects are not 
automatically rescaled (to rescale objects choose Scale from the Edit menu).

When you have selected your drawing scale, units of measure, drawing 
method, and scale increments, click OK.

NOTE: Remember, you can go back at any time in the drawing process to 
change the scale, page size or any other drawing setup preference. 

Detailed descriptions of all the Drawing Setup options may be found in the 
Menu chapter, Layout, Drawing Setup.

💬💬
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What drafting machine angles do we want to use? 
Choose Drawing Setup from the Layout menu, select the Snap Tab and the 
following dialog will appear:

Using the default constrained snap angles allows you to quickly create 
geometry at the specified angles, which is much like you did using the preset 
angles on drafting machines or adjustable triangles.  Depending on your 
drawing requirements, you may choose to use your own custom snap angles 
or a combination of the default and custom angles.

NOTE: Whether you create illustrations, technical drawings or anything 
in-between, snapping is the most important skill you can master to get the 
most out of PowerCADD.  Please take some time and review the snapping 
examples in this chapter as they lay the foundation for PowerCADD 
becoming a natural extension of your drawing and design process.

Detailed descriptions of all the Drawing Setup Snap Angle options may be 
found in the Menu chapter, Layout, Drawing Setup, Snap.

Only the basic options are being explored here.  Drawing Setup allows 
full customization of many drawing characteristics such as Nudge.  Other 
Preference options are explained in detail in the “Using PowerCADD 
Menus” chapter.  Angles may be changed by standard text editing techniques.  
Click OK when you are satisfied with your selection.

💬💬
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Dialog boxes are an integral part of all Macintosh programs, including 
PowerCADD.  Using the mouse, you can navigate the dialogs and activate 
options easily. 

With every Macintosh program key commands are used.  There are some 
standard ones that every program uses, Command-P for Print, as an example. 
As you become more familiar with PowerCADD, you may find that using 
keyboard shortcuts, or even creating your own key commands, will make 
your design and drawing practices more efficient.  If you have been using 
another CAD program or are familiar with certain key commands and 
would like to use the same key commands for PowerCADD, you can create 
your own custom keyw commands in PowerCADD to suit your needs.

For more information about creating your own key commands, see 
Commands.

Dialog Boxes
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Once you have completed setting up your drawing specifications, you are 
ready to begin your design.  To save time when creating future drawings, 
you can save all your preferred settings (and any standard objects such a title 
block) as a stationery pad drawing (or template).

You can access your saved Stationery by double-clicking on it at the Desktop 
or using the New command from the File menu.  The original remains 
intact until you save changes by using the exact same name to replace this 
stationery template.

Stationery is an integral part of the drawing process.  Paper sizes can be 
saved; even title blocks can be used in your stationery.  Even though there 
is nothing like a little planning, you can change your stationery when you 
find something else you want to add.  Simply make the desired changes and 
save the new version into the Stationery Folder inside the PowerCADD 
Application Folder.  If the new stationery has the same name as the old one, 
the new item will replace the old one.  To make a new variation simply give 
the new stationery drawing a unique name when saving or moving it into 
the PowerCADD Stationery Folder.

TIP: PowerCADD offers a simple and efficient method for organizing and 
accessing your stationery files.  Review Working With Stationery in the 
Menu chapter on using, opening, and adding stationery drawings.

Stationery
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Dynamic Snapping allows you to specify the type of snap that will be 
performed. Snap commands such as Grid, Vertex, Axis Align, X Intersection, 
Surface, Tangent, Perpendicular, Center, End, % Percent, Distance and 
Offset can be used to specify a snap location.  

These key functions override all other snaps contained in PowerCADD.  

To use these snap functions, press the key indicated in bold type and select 
or draw an object.  Move or drag the object into position.  When you are 
close to the specified snap point, the Snap Locator will appear.  The Snap 
Locator is a small bullet that displays the snap point when the cursor is “on 
target”.  The Snap Locator will appear in red.  The Dynamic Snap Indicator 
floating window will verify the type of snap located. 

PowerCADD continuously monitors the condition of the snap keys. 
Holding a snap key while close to a snap condition will force the snap to 
occur.  For the snap to be committed to the drawing, the mouse must be 
released before releasing the snap key.  If the snap key is released before the 
mouse button, PowerCADD will assume you did not want to snap. If you 
work too quickly, you can get the snap-key release out of sequence.

When snapping from a point in the drawing area to a snap point, the 
resulting object is frozen in place.  If you begin drawing snapped to a point, 
the resulting object will be movable and must be established by specifying 
an end point.

If you want to temporarily turn all snaps off while drawing, moving, 
resizing, or reshaping objects, press the Command key.

Dynamic Snapping

Dynamic Snap Indicator

Anchor
[DynamicSnapping]
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Grid allows you to align objects to the grid.  This will turn the grid on 
momentarily if it is turned off.  Grid snapping does not have a Snap Locator 
at snap points, but will be highlighted in the Dynamic Snap Indicator. 

To use dynamic Grid snap:
	 While drawing, moving an object, or positioning the cursor, press and 

hold the G key
	 Drag or move the cursor toward the desired grid.
	 The object will snap to the grid with respect to the present grid setting.
	 Release the mouse button before releasing the G key to insure the snap 

is performed.

Grid snap is a normal snap when Object Snap is On.  The G key assumes 
only the grid will be snapped.  The G key will force a grid snap even when 
near a vertex.

Grid Snap
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Vertex allows you to snap to the vertices of objects. Vertices are line end 
points, vertices of polygons, top, right, bottom, and left extremes of circles 
and ellipses, arc end points, etc.

To use Vertex snap:
	 While drawing, moving an object, or positioning the cursor, press and 

hold the V key.
	 Drag or move the cursor toward the desired vertex.
	 When the snap position has been defined, the Snap Locator will appear 

and the letter V will be highlighted in the Snap Indicator.
	 Release the mouse button before the V key to insure the object does 

not move off of the vertex.

Vertex snap is a normal snap when Object Snap is On.  The V key assumes 
a vertex will be snapped, if available, regardless of the On/Off condition of 
Object Snap.

Vertex Snap

Vertex snap was expanded in PowerCADD 8 to include the mid points of 
rectangles, round rectangles, arcs and similar objects.  As illustrated below, if 
Quick Handles is turned off in Preferences, it will appear as if PowerCADD 
is snapping to the object handle bars.  If the Quick Handles Preference is 
Off it will appear as if PowerCADD is snapping to the mid point of the 
objects surface.

Snap
Points

Anchor
[VertexSnap]
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Axis Align snapping allows you to align an object horizontally or vertically 
with points on another object.  When a snap occurs, the A in the Dynamic 
Snap Indicator is highlighted and a ghost horizontal or vertical line connects 
the points being aligned. 

Axis Align displays these ghost or projection lines from the end points, 
midpoints, centers or vertices of all visible objects displayed on the screen. 
You control the area available for snapping by zooming.  Zoom in or out 
to control the visible area and therefore the range of snapping.  Snapping 
extends horizontally and vertically. Snapping occurs only within the visible 
area of the drawing window.

Both a horizontal and vertical snap can occur at the same time, and the 
snap points can be on the same object or on two different objects.  You 
may also choose the snap to be only vertical or horizontal or both by 
tapping the Option key while pressing the A key.  Axis Align will toggle 
between horizontal, vertical, or both with each press of the Option key 
while pressing the A key.  The ghost lines will toggle through horizontal to 
vertical and back to both.

Axis Align helps you construct orthographic projections or views easily and 
quickly.  It can also be used when moving or resizing an object.

Axis Align

To use Axis Align snap:
	 Press A and select or draw an object.
	 Move the object close to the axis to be snapped.
	 When the snapping point has been defined, the A will be highlighted in the 

Snap Indicator and a ghost line will connect the cursor and the snap point
	 Release the mouse button before you release the A key to insure the 

object remains aligned with the snap point.
–or–
	 Select a drawing tool.
	 Press the A key and bring the cursor near where you want to start 

drawing.  Move the cursor until a ghost snap line connects the cursor 
and the appropriate snap point.

	 Press the mouse button, begin drawing, and release the A key.

snap locator

snap locator

red snap guide appears

Anchor
[AxisAlign]
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Intersection X snapping allows you to snap an object to the intersection of 
other objects. 

Two points to remember: 
	 One, press the X key long enough for PowerCADD to find the closest 

intersection, and
	 Two, press the X key until the mouse is released.

Intersection Snap
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Surface allows you to snap an object to the surface (the perimeter line) of 
an object. 

For example, to draw a line that must contact a circle, press the S key and 
drag the object into the circle. 

As you get closer to the circle’s surface, the object will jump to the circle’s 
perimeter. 

The cursor may then be moved around the circle to place the line, while the 
line end never breaks contact with the surface of the circle.

To use Surface snap:
	 Press the S key and select or draw an object.
	 Move the object close to the surface to be snapped.
	 When the snap position has been defined, the Snap Locator will appear 

and the letter S will be highlighted in the Dynamic Snap Indicator.
	 Release the mouse button before releasing the S key to insure the snap 

remains intact.

Surface Snap
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Tangent allows you to snap a line tangent to the surface of a circle, ellipse, 
or arc. 

Drag a line to the circle’s surface, press the T key and the snap will occur. 

Or begin at the circle surface and drag the object out while pressing the T  
key. 

The first option allows you to move an object close to the circle’s surface and 
establish the snap by watching the Snap Locator.

The second option allows you to begin drawing at the circle’s surface and 
drag out. 

As you drag the cursor out, you will notice the object can be moved around 
the circle while remaining snapped tangent to the circle’s surface. 

When you release the mouse button, the object is established.

To use the Tangent snap:
	 Select a Line tool from the Tool palette.
	 Start to draw the line towards the circle.
	 When the cursor is on the perimeter of the circle, press the T key.
	 When the snap point has been defined, the Snap Locator will appear 

and the letter T will be highlighted in the Dynamic Snap Indicator.
	 Release the mouse button before releasing the T key to insure the snap 

remains.
–or–
	 Select a line tool from the Tool palette.
	 Press the T key and place the cursor on the perimeter of the circle, and 

press the mouse button.
	 Drag the cursor away from the circle.  After the first cursor movement, 

release the T key.

A tangent line will appear which can be moved around the circle by moving 
the cursor. This allows you to place the tangent line at any point around the 
circle’s perimeter.

Circles may be drawn tangent to circles and arcs, as shown in following 
example.  To draw circles tangent from lines, rectangles, polygons or bézier 
curves, use Perpendicular snapping as described later in this section.

When dragging circles tangent to other circles or arcs, notice the circle may 
be pulled to the opposite side of the object or around the objects but cannot 
be pulled off the object.

Tangent Snap

Draw circles tangent to other arcs or circles

Draw other geometry tangent to circles or arc

Anchor
[TangentSnap]
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Perpendicular allows you to snap an object perpendicular to the surface of 
another object.  

The option of drawing from the surface out or in towards the surface (as 
with the Tangent snap) applies here also. 

To use Perpendicular snap:
	 Press the P key and draw an object. 
	 Move the object toward the surface to be snapped. 
	 When the snap position has been defined, the Snap Locator will appear 

and the letter P will be highlighted in the Dynamic Snap Indicator.
–or–
	 Select a drawing tool from the Tool palette.
	 Press the P key and place the cursor on the perimeter of the snapping 

surface and press the mouse button.

A perpendicular line will appear which can be moved parallel to the surface 
being snapped to.  This will allow you to place the perpendicular object at 
any point along the snapping surface.

Perpendicular Snap

 Examples of lines drawn perpendicular

1
1

1
1

1

1

1

1

1

1

2 2 2
2

2

2

2
2

2

2 2
2

2

1

1

1

Anchor
[PerpendicularSnap]



Tutorial34

Center allows you to snap an object to the center point of another object. 
Center snap also gives you the option of snapping from center out or from 
the outside to the center.

To use Center snap:
	 Select or draw an object.
	 Press the C key and move the object to the perimeter of the object 

being snapped.
	 When the snap position has been defined, the Snap Locator will appear 

and the letter C will be highlighted in the Dynamic Snap Indicator.
	 Release the mouse button before the C key to insure the snap remains 

intact.
 –or–
	 Select a Line tool from the Tool palette.
	 Press the C key and place the cursor on the perimeter of the object to 

be snapped to and press the mouse button.
	 Drag the cursor outside the object and release the C key.

A line will appear. Its origin will be at the center of the center-snapped 
object and its end at the cursor.  The line will follow the cursor around the 
center until the mouse button is released.

Center snap allows you to snap one object to another; consequently the 
centers of the two objects will be aligned.

The center of an arc is in the same location as if it were still part of a circle 
or ellipse.

Line Center snap is a normal snap when object snap is On. Other objects 
must be dynamically snapped using the C key.  The C keystroke assumes 
a Center snap will be performed, if available, regardless of the On/Off 
condition of Object Snap.

Center Snap

Anchor
[CenterSnap]
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End snap allows you to snap or relocate an object to the endpoint of an 
object.  It works much like Vertex, the items are snapped to end points and 
corners of objects. 

For objects having more than one corner, such as rectangles, the closest 
corner will be found. 

Unlike Vertex snap, the end point does not need to be close or even on the 
screen.

End Snap
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% Percent snap allows you to specify how far along a line segment the snap 
will occur by entering a percentage. 

The percent you enter correlates to the surface being snapped to.

Center snap equals 50% snap, one quarter of a line segment equals a 25% 
snap, etc.

Unlike Center snap, the snap point is along the object’s surface rather than 
its middle.

To use Percent snap:
	 Draw a line and bring the cursor near the surface to be snapped to.
	 Press % (actually the 5 key) and the Snap Locator will appear.  The 

line will snap to the percentage amount specified in the Percent dialog. 

To change the Percent Snap:
	 Press the Option key and %.  A dialog will appear.

Percent Snap

	 Press the Tab key to activate the edit field and enter the desired 
percentage.

When you click OK, the setting is in effect and will not change until you 
repeat this process.

The percent snap is set by pressing Option-% before or during drawing.  
The percent is measured from the point/vertex nearest the mouse selection 
location.  A percent greater than 50 percent will snap to the further end of 
the line.  The percent snap will assist in snapping to the center of polygon 
sides and the sides of rectangles.

Anchor
[PercentSnap]
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Distance allows you to specify how far along a line segment (e.g. a line 
segment is one face of a rectangle, or the face or segment of a polygon) the 
snap will occur by entering a specific distance.  

Distance snap is similar to Percent snap in that the snap point is along the 
object’s surface.  

The distance you enter for the snap is relative to the scale and units you 
specified in Drawing Setup. 

To use Distance snap:
	 Draw a line and bring the cursor near the surface to be snapped.
	 Press the D key and the Snap Locator will appear.  The line will snap to 

the distance specified in the Snap Distance.
 –or–
	 Select a drawing tool from the Tool palette.
	 Press the D key and place the cursor on the perimeter of the snapping 

surface, and press the mouse button.
	 Drag away from the object and release the D key.  Release the mouse to 

complete the drawing operation.

The Distance snap is set by pressing Option-D before drawing.  The distance 
is measured from the vertex nearest the mouse selection location. 

To change the Distance Snap:
	 Press the Option key and press D.  A dialog will appear.

Distance Snap

	 Press the Tab key to activate the edit field and enter the desired distance. 
Remember, distances are entered based on the current drawing or layer 
scale settings.

When you click OK, the setting is in effect and will not change until you 
repeat this process.

Anchor
[DistanceSnap]
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Offset snap allows you specify how far away from an object’s vertex a snap 
should occur.

To use Offset snap:
	 Draw a line and bring the cursor near the surface to be snapped.
	 Press the O key and the Snap Locator will appear.  The line will snap to 

the distance specified in the Snap Offset dialog box.
–or–
	 Select a drawing tool from the Tool palette.
	 Press the O key and place the cursor on the perimeter of the snapping 

surface, and press the mouse button.
	 Drag away from the object and release the O key. Release the mouse to 

complete the drawing operation.

The offset snap is set by Option-O before drawing.  The distance is measured 
from the vertex nearest the mouse selection location.

To change the Offset snap:
	 Press Option-O.  The following dialog will appear:

Offset Snap

	 Press the Tab key to activate the edit field and enter the desired X and 
Y offset distances. 

 Remember, offset distances are entered based on the current drawing 
or layer scale settings.

When you click OK, the setting is in effect and will not change until you 
repeat this process.

Anchor
[OffsetSnap]
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The tools for making objects adjacent, aligning line ends and aligning object 
vertexes to each other are natural features of PowerCADD.  The tools and 
techniques are both intuitive and very fast, but they are not always readily 
apparent.

Adjacency is basically a surface-to-surface snap.  No special commands 
are necessary, because adjacency occurs naturally in PowerCADD.  It is 
sometimes not recognized, and seeing is believing.  The following provides 
an extreme example so you can see it in “action”. 

Draw any two rectangles off the grid.  The easiest way to draw off the grid 
is to press the Command key while drawing.  Set the Divisions/Units in 
Drawing Setup to be very coarse, for example, so you can clearly observe 
the next actions

Press the S key while selecting one of the rectangle’s sides.  Drag the rectangle 
to the surface of the other rectangle.

Release the mouse, then release the S key.  The surfaces snapped together 
and are now adjacent. 

Of course, the surface snapping process could have occurred during the 
original drawing process.  Remember to reset Divisions/Units to their 
original settings.

To show how to align the end of a line with a vertex of another object or 
another line end without changing the angle or length of the line, draw two 
lines at any angle. 

Deselect both lines.

Select the first line at approximately the end point of the line, or press the 
E key while selecting.

With Object snap On, drag the first line to the end of the second line.  
When released, the line ends will be snapped together. 

Naturally, the Move cursor must be within snapping distance.  Seeing the 
V highlight in the Snap Indicator assures you have snapped the objects 
together. 

Also, remember it is the location where the first line is established, that 
is snapped to the closest vertex.  PowerCADD provides a snap point at 
the midpoint of each line drawn, a snap point at each circle center and at 
North, East, South, and West of the circle surface.  Also snap points are at 

Adjacent Objects

Anchor
[AdjacentObjects]
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each arc radius point and at their arc ends. 

Polygon vertex snapping can be accomplished similarly by selecting the 
polygon by a vertex to move it to a new location or to other snap points 
on other objects.  Under reshape, a polygon vertex can be snapped to other 
objects or to a vertex in the same polygon.  Dynamic snapping can be used 
anywhere during the drawing process.
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Snapping is a basic and important part of precision drawing in PowerCADD. 
Snapping objects together, while drawing or selecting, assures you the 
objects are placed accurately. While doing the following exercises, you 
will discover the power and positive control of one mouse finger and one 
keyboard finger, you will maximize visual confirmation, speed and accuracy 
of snapping, and you will save on eye strain of manual mouse precision.
 
To guide you through this part of the interface, do the following:

	 Select the Line tool  from the Tool palette by clicking on it.
	 Draw two horizontal lines shown as E-to-E and P to P.

Exercises Using

	 Next, draw a line from the P/P line to the E/E line by using dynamic 
snapping.

Ensure the same Line tool is selected and complete the following steps, 
slowly at first:

	 Press the E key and continue to hold it down.
	 Place the cursor anywhere along and directly upon the drawn P/P line.
	 Press the mouse button.

 NOTE: The E of the Dynamic Snap Indicator will turn red to confirm 
the End Snap and the Dynamic Snap Locator will be visible.

	 Draw a line towards the E/E line.
	 Touch anywhere on the E/E line.
	 Release the mouse.
	 Then release the E key.

Repeat the above steps, but do not be precise as to where upon the P/P or 
E/E lines you place your cursor, and you will see how dynamic and positive 
pressing the E key can be.

By following the same procedure, but using different snap keys, do the 
following:

E E

P P
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	 Draw a line from the P/P line by using the Perpendicular Snap–once 
the P snap is invoked (steps 1 through 4). Slide your mouse (and the 
line) left to right and back to left to see the staying power and flexibility 
of the perpendicular snapping.  Finish steps 5 through 7 by using a 
Center snap on the E/E line.

Draw two lines from P/P by using an End snap on the E/E line and a % 
snap (keyboard 5) of 50% on the E/E line for each to complete this figure.

	 Select the text while pressing the C key. 
	 Keeping the mouse button down, start to drag the text block towards 

the line.

E E

P P
P

%
C

Draw two circles and an arc similar to the following.

C

T T

C

TT

C

T

Use the Line tool and the keyboard snaps indicated and complete the above 
exercise.

Examine the action, which took place while drawing the previous figure. 
Notice, whether you were drawing methodically slow or quickly, the 
dynamic snapping was very fast and positive.

Select All from the Edit menu, press the Delete key to clear the screen, and 
let’s start fresh.

Dynamic snapping is not only useful for drawing, but also for selecting 
objects, moving objects, and placing them precisely.

Draw a rectangle, a line and type the word Text using the T (text) tool 
similar to this:

TEXT
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	 Keeping the mouse button down, start to drag the text block towards 
the line.

	 Insert the text by placing the cursor anywhere on the line and pressing 
the C key.

	 Release the mouse button, then release the C key.

 NOTE: The center of the text is now placed on the center of the line.

 NOTE: Once an object is selected by a chosen snap, the snap key can 
be released.

	 Select the rectangle while pressing the C key, drag to the line and press 
the E key.

	 Select All from the Edit menu, press the Delete key to clear the screen 
and let’s start fresh.

TEXT

C to C

C to E

	 Draw two lines and a circle, like this but larger:

	 Draw a polygon using snapping.
	 Start with a Center snap to circle - click - followed by a Perpendicular 

snap to first line - click - End snap to the second line - click - Center 
snap to the first line - release - Tangent snap on the circle double-click.

C T
P

C

E

At this point you will have discovered the power and positive control of 
one mouse finger and one keyboard finger, and how easy it is to accomplish 
decisive navigation with speed and accuracy.

The basic routines you have learned do not restrict you, but rather, do the 
opposite.  When using snapping, you only have to be reasonably close with 

💬💬
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your mouse targets to let PowerCADD’s snapping provide you with exact 
precision. Besides, being too close limits the full graphic communication to 
you of the confirmation of such snapping precision.
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The Edit Window allows you to resize, position, and rotate objects precisely 
using the Macintosh keyboard.  You may specify the exact increments an 
object is to move or rotate, or specify where points of an object are to be 
placed in relation to the drawing origin.

Edit Window

size box.

A preview or the new Edit Window�
shape appears when resizing.

Close button.�
Click this to close the Edit Window

Edit Window Display.�
Click to toggle the number of�

fields displayed in the Edit Window. Click and drag on the size box to �
change the size or orientation�

of the Edit Window.
Layer: Displays the layer name the�

selected object is on.
Area: Current area calculation based�

on drawing units and scale.

Perimeter: Current calculation of the�
objects perimeter length based on�

drawing units and scale.

If you are have a small screen, you may change the shape of the Edit Window 
to maximize the use of screen.  To change the shape of the window, drag the 
window from the resize box to the shape and size you need. 

Size Box: To change the size or orientation of the Edit Window click and drag here.

Object Type: The type of object selected�
is displayed in the Title Bar.

Title Bar: To move the Edit Window�
click and drag the title bar.

The placement of the Edit Window is dependent only upon what you find 
the most convenient.  The Edit Window can edit an object during or after 
creation.  The Tab key will activate the Edit Window any time an object 
is selected or being drawn, regardless of the On/Off condition of the Edit 
Window.  Once the Edit Window is active you may Tab to the correct field 
and enter the desired information in that field.  To execute the change, click 
in the drawing or press the Return or Enter key.

To specify the first point of an object: 
	 Select a tool.
	 Press the Tab key to activate the Edit Window.
	 The first field will highlight.  Type the desired coordinate and press the 

Tab key to move to the next field.
	 Type the desired coordinate and press the Enter key. The remaining 

fields will appear in the Edit Window.  You may continue to move 
through the Edit Window, entering coordinates to complete the object 
or use the mouse. 

NOTE: If the Edit Window is closed (hidden), the Tab key will open it for editing.💬💬

Anchor
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To resize an existing object:
	 Select the object you wish to resize.
	 With the object selected, press the Tab key.
	 Tab to the field labeled Left and enter a value, which will tell 

PowerCADD where to place the left side of the bounding rectangle 
with respect to the horizontal ruler.

	 Once Left is entered, Tab to the field labeled Top and enter a value 
telling PowerCADD where to place the Top of the bounding rectangle 
with respect to the vertical ruler.  The top left hand point of the objects 
bounding rectangle is now specified.

	 Tab to the field labeled Right and enter a value telling PowerCADD 
where to place the right side of the bounding rectangle with respect to 
the horizontal ruler.

	 Once Right is entered, Tab to the field labeled Bottom and enter a 
value telling PowerCADD where to place the bottom of the bounding 
rectangle with respect to the vertical ruler.  The lower right hand corner 
of the object’s bounding rectangle has now been specified.

	 Now that all four sides of the bounding rectangle have been specified, 
pressing the Return or Enter key, Enter, or clicking the mouse button 
in the drawing will execute the command.

To size an object while creating:
	 Select a drawing tool from the Tool palette and begin drawing the 

object.
	 Before you release the mouse button to establish the object’s origin, 

press the Tab key to activate the Edit window.  Once a field of the Edit 
Window is highlighted, you may release the mouse.

	 Use the procedure described above to specify the coordinates.
	 When you specify the corners of the object’s bounding box, the object 

is locked into that location until you change it.
	 When you edit-resize a rotated object, the information given in the 

Edit window correlates to the object in a non-rotated state.

To edit-rotate an existing object:
	 Select the object you wish to edit-rotate.  This object must be set at 

any angle other than a multiple of 90˚.  If the object is already set at a 
multiple of 90˚, the angle field will not be displayed in the Edit window.  
In this case you must use Option-Rotate under the Arrange menu.

	 Press the Tab key to activate the Edit Window.
	 Tab to the field labeled Angle and enter the desired angle value.  When 

the object is rotated, its original starting point will remain stationary 
while the line snaps to the correct angle.  The angle you enter is an 
absolute value.  For example, if the current line is at an angle of 55˚ 
and you specify 45˚, the line will snap to 45˚ from 0˚ or horizontal.  
The specified angle is measured from zero and not the present angle.

Resizing Existing Objects

Size While Drawing

Rotate Existing Object
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	 A mouse click in the drawing, or pressing the Return or Enter key, will 
execute the command. 

When rotating an object using the Edit Window, the rotation units will 
correspond to the angular units specified in Drawing Setup. If the Angular 
Units are set to Gradients, the rotation as well as the value entered will 
be based on Gradient measure. To make data entry easier when entering 
angles in Degrees, Minutes and Seconds, you only have to enter the values 
followed by a space. For example, to specify an angle of 45º 15’ 25”, you 
only need to type 45 15 25 and PowerCADD will do the rest.

To rotate an object while creating:
	 Select a tool and begin drawing the object. The only tools allowing you 

to set the angle are: the Line tools, the Rotated Rectangle and Ellipse, 
the Circular Arc tools, the Polygon tool, the Regular Polygon tool, and 
the Linear Dimension tools. These are the tools that will allow you to 
start the object at an angle other than 90˚.

	 Before you click to establish the first side, Tab to the Angle field in the 
Edit window and enter a value corresponding to the current angular 
unit setting

	 Click in the drawing or press the Return or Enter key to execute the command.

When you specify an angle of rotation, the object is locked to that angle 
until you change it.

Following is a listing and explanation of the fields, which may appear in 
the Edit Window for any given object.  All fields display and accept values 
based on the current drawing setup units.  Area and Perimeter units may be 
different than the base drawing units.

TIP: You can change the number of fields displayed in the Edit Window. 
See examples later in this chapter to learn more.

X start specifies the horizontal location of the starting point.
Y start specifies the vertical location of the starting point.
X end specifies the horizontal location of the end point.
Y end specifies the vertical location of the end point.
Delta x specifies the horizontal change from the starting X location to the 
ending X location.
Delta y specifies the vertical change from the starting Y location to the 
ending Y location.
Length specifies the distance from the starting point to the ending point.
Angle specifies the present angle of the drawn object.  This is only active in 
specific tools.

Rotate While Drawing

Edit Window Fields

💡💡
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Radius specifies the radius of circles or circular arcs.
Diameter specifies the diameter of circles or arcs.
X center specifies the center of an ellipse or an elliptical arc with respect to 
the horizontal axis.
Y center specifies the center of an ellipse or an elliptical arc with respect to 
the vertical axis.
Radius x specifies the horizontal radius of an ellipse or an elliptical arc.
Radius y specifies the vertical radius of an ellipse or an elliptical arc.
Start ang specifies the quadrant in which an elliptical arc is drawn.  For 
example, the top right corner of an ellipse is the 90˚ quadrant; the upper 
left corner is the 180˚ quadrant, etc.
Arc angle specifies the angle or portion of a circle an arc represents.
Left specifies the left side of the object’s bounding rectangle with respect to 
the horizontal ruler.
Top specifies the top of the object’s bounding rectangle with respect to the 
vertical ruler.
Right specifies the right side of the object’s bounding rectangle with respect 
to the horizontal ruler.
Bottom specifies the bottom of the object’s bounding rectangle with respect 
to the vertical ruler.
Width specifies the width of the object’s bounding rectangle.
Height specifies the height of the object’s bounding rectangle.
X center specifies the horizontal center of the object with respect to the 
horizontal ruler.
Y center specifies the vertical center of the object with respect to the vertical 
ruler. 
Scale X scales the object in the X or horizontal direction.
Scale Y scales the object in the Y or vertical direction.
Area specifies the area of object in the specified drawing area units.  This 
field cannot be edited. 
Perimeter specifies the perimeter of an object in the specified drawing 
units.  This field cannot be edited. 

NOTE: You can also enter mathematical equations or specify units in the 
Edit Window to perform complex calculations.  For example, if the drawing 
units are set you inches, you can specify a dimension in millimeters and 
PowerCADD will perform the conversion for you.

See the Menu Chapter for more information on working with the Edit 
Window and performing mathematics in the Edit Window and other 
dialogs.

💬💬
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Exercises with the Edit Window
The Edit Window is a fundamental tool in PowerCADD that provides you 
with the ability to type in object location and size.  You will use this window 
often and are encouraged to complete the following exercises to get a head 
start in your drawing process.

	 Choose Edit from the Windows menu.

	 Place (drag) the square Edit Window into the top right corner.  (Drag 
the Edit Window by the title bar.)  

	 Click on the green button to change how many fields the Edit Window 
displays.

size box.

A preview or the new Edit Window�
shape appears when resizing.

Close button.�
Click this to close the Edit Window

Edit Window Display.�
Click to toggle the number of�

fields displayed in the Edit Window. Click and drag on the size box to �
change the size or orientation�

of the Edit Window.
Layer: Displays the layer name the�

selected object is on.
Area: Current area calculation based�

on drawing units and scale.

Perimeter: Current calculation of the�
objects perimeter length based on�

drawing units and scale.

Size Box: To change the size or orientation of the Edit Window click and drag here.

	 Reshape the Edit Window by dragging the resize box in the right-
bottom corner.

	 Place (drag) the rectangular Edit Window along the bottom of your 
screen. (Remember, you can drag the window by its title bar.)

	 Resize the Edit Window from horizontal to vertical. 

For convenience, PowerCADD always remembers the last location you left 
the Edit Window and the shape.

The Edit Window not only provides information while you are drawing, 
but allows the direct editing of objects while they are being drawn and after 
they have been drawn.

	 Draw a line slowly at any angle and watch the Edit Window provide 
interactive information feedback while you are drawing. 
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To use the Edit Window to edit the angle of the line:
	 Select the line,
	 Click on the text field of angle and use normal text editing method to 

change the angle.
	 Finish by pressing the Return or Enter key.

NOTE: Use this method to edit any object’s specifications.

To try the full interactive modeless, mouse and Edit Window drawing 
power of PowerCADD, complete the following:

	 1) Select the Rectangle tool.
	 2) Start to draw a rectangle and immediately press the Tab key.
	 3) Release the mouse.

NOTE: The mouse operations are temporarily suspended when you press 
the Tab key.

	 4) Press the Up arrow to cycle to the width field, enter 3” (3 inches).
	 5) Press the Return key.
	 6) Move the mouse to resize the rectangle before clicking the mouse. 
	 7) To complete the rectangle, click the mouse button once.  

The Edit Window has more than just simple editing capability.  

You can use the Edit Window’s automatic conversion (imperial to metric, 
metric to imperial, and decimal vs. fractions) and its +, –, /, and * arithmetic 
calculation ability in the same straightforward manner.  

PowerCADD eliminates the need for a calculator and provides international 
conversions seamlessly.  

The following is an example.
	 1) Select a rectangle.
	 2) Click into the height field of the Edit Window.
	 3) Type 3” + 30 cm (3 inches plus 30 centimeters).

Now you have entered one imperial and one metric measurement. 
PowerCADD will automatically convert both to the default setting of the 
drawing and add the two together accurately.

	 4) Press the Return key.
	 5) Try a simple multiply (*), divide (/), and subtract (–) in the same 

manner.

This doesn’t work.

💬💬

💬💬
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To use the keyboard for drawing:
	 1) Select the Rectangle tool.
	 2) Use a single mouse button press to define the x, y starting point 

followed immediately by pressing the Tab key.
	 3) Type the values of both the width and height fields in the Edit 

Window.
 
 The Tab key will move you from box to box.

	 4) Press the Enter key.

Text can be copied between text information on the drawing and the Edit 
Window information fields or vice versa.

	 1) Draw a rectangle.
	 2) Click in the Edit Window height field. 
	 3) Make sure all selected text is highlighted.
	 4) Copy, using the Copy command from the Edit menu.  
	 5) Select the Text tool.  
	 6) Click in the drawing area and paste the copied text, using the Paste 

command from the Edit menu. 
	 7) Text-edit the same text information in the text block.
	 8) Select the edited text and copy, using the Copy command.
	 9) Select the Selection Arrow tool.
	 10) Make sure all the height field is selected.  
	 11) Paste the copied text, using the Paste command. 
	 12) Press the Enter key.

	 1) Close the Edit Window by clicking in the close box of the Edit 
Window title bar. 

	 2) Select the rectangle.
	 3) Press the Tab key.
	 4) Change heights and values. 
	 5) Press the Enter key.

The above are just a few of the ways you may use the Edit Window.  As 
you get more proficient with the tools and menu commands, you will find 
the Edit Window to be more and more useful and a wonderful time-saving 
feature. 

After you have spent some time with the manual learning about the 
additional features, tools, and commands, come back to the exercises on 
using snapping and the Edit Window to reinforce what you have learned.
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Math in Dialog Boxes
Math can be performed in any dialog box that accepts keyboard-typed 
input.

You may also enter equations having primary and secondary functions 
such as (2+4)-(3*6) or items of different measurement systems such as: 
34"/66mm. 

Here are some possible combinations of mathematical equations:
 17/256 + 1/8
 15"*(3"+24mm)
 2.549/12mm
 13/254 + 16mm - .2568 / 56mm

The abbreviations are:
 ' = feet
 " = inches
 mm = millimeters
 M = miles
 cm = centimeters
 m = meters
 km = kilometers

Parentheses may be used to specify priority. Multiply and divide are 
evaluated before add and subtract.
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[MathInDialogBoxes]
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Putting It All Together
Now that you have been working with snapping and the Edit Window, let’s 
take it one step further with an exercise in how to use both the snapping and 
the Edit Window with PowerCADD’s math capabilities in any dialog box. 

PowerCADD can do math (add, subtract, multiply or divide) in any dialog 
box that accepts input, even mixed types of measurements (centimeters, 
millimeters, inches, feet, etc.).  You used it with the Edit Window in the 
previous exercises to add 30 centimeters to 3 inches.  It is very handy when 
you need to change the length of a line or even more complicated issues. 

For this exercise, we are going to create a bearing using the Circle by Radius 
tool, the Circle by Diameter tool, the Parallel Offset tool, the surface snap, 
and the Duplicate command in the Edit menu.

Open a new drawing (choose Open in the File menu).  Leave the scale of 
the drawing at 1:1 for this exercise.

	 Select the Circle by Radius tool.
	 Place your cursor on the 2” xy axis.

HINT: Look in the rulers for the gray line indicating your position.

Don’t worry if you don’t get it exactly right, we are going to use the Edit 
Window to position it in the exact location we want it.

	 Drag the mouse to the right and press the Tab key. 

 This will put you into the Edit Window.
 
	 Type 1 1/2” into Radius field.
	 Press Enter and you should have a 3” circle as pictured in the following 

example.

	 Press the Option key and select the Parallel Offset Tool from the Tool 
palette. 

💡💡

Anchor
[PuttingItAllTogether]
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The following dialog will appear:

	 Type 1/2 or .5 in the Offset box.  

 Make sure Interactive is not selected and the number of offsets is set to 1.

	 Click OK.
	 Place the cursor on the perimeter of the circle you drew.
	 Drag the mouse toward the center of the circle.  When it stops click the 

mouse button and you should have a circle with its x and y center at 
2”, with a radius of 1” and a diameter of 2” like the following example.

	 Select the Circle by Diameter tool from the Tool palette.
	 Move the mouse to the perimeter of the first circle you drew and press 

the P key for a Perpendicular snap.
	 Drag to the second circle holding the S key and you will snap to the 

surface of the second circle.  Release the mouse button and you should 
have a small circle touching both larger circles like the following example.

	 While the smaller circle is still selected, choose Duplicate from the Edit 
menu while pressing the Option key.
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As with all tools and menus with two dots, a dialog box will be presented 
with additional options for the tools or menus.

For this example, choose the Circular duplication.  You want 12 duplications, 
so enter 12 for the number of duplications.

Since you want these to be spaced out in the circles and you don’t know the 
exact angle to make this happen, you are going to let PowerCADD figure 
that out by typing 360/12 into the Angle box.  Make sure Rotate Item is 
selected.

Since you don’t know precisely where on the page the center of the circle 
is, you’re going to use a mouse click to tell PowerCADD where the center 
point of rotation and duplication should be.  Your dialog box settings 
should look like they do below and click OK.

After you clicked OK, you were returned to the drawing and your cursor 
changed to a target cursor.  Your next mouse click will determine the center 
point for rotation and duplication. 

Place the cursor over the edge of the largest circle and press the C key.  A 
red snap indicator will appear at the center of the circle, when you see that 
snap indicator click the mouse. 

After you click, release the C key.  The results are as shown below.  Remember 
to make sure you see the red snap indicator at the center of the circle before 
clicking the mouse.

When using math in the dialog boxes you may also enter equations having 
primary and secondary functions such as (2+4)-(3*6) or items of different 
measurement systems such as: 34”/ 66mm. 
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Parentheses may be used to specify priority. Multiply and divide are 
evaluated before add and subtract.

You have now been introduced to how to set up your drawing scale and 
your page size and what preferences is all about.  You have worked with 
dynamic snapping, the Edit Window and have been introduced to using 
math in the dialogs.  As you proceed to the next chapter, you will learn 
even more techniques and concepts that will enable you to be even more 
productive, no matter what you draw.
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